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1. System configuration 

The system configuration of TOP and “KOYO Electronic Industries Co., Ltd. – DirectLogic Series Computer Link” is as follows. 

 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

DL-205 

D2–240 
communication 

port 2 on CPU 
RS–232C 

3. TOP communication 

setting 

4.1. External device 

setting 1 

5.1. Cable table 1 

D2–250–1 
communication 

port 2 on CPU 
RS–232C 

3. TOP communication 

setting 

4.1. External device 

setting 1 

5.2. Cable table 2 

D2–260 

communication 

port 2 on CPU 
RS–232C 

3. TOP communication 

setting 

4.1. External device 

setting 1 

5.3. Cable table 3 
communication 

port 2 on CPU 
RS–422 (4 wire) 

DL-405 

D4–403 D4–DCM 

RS–232C 
3. TOP communication 

setting 

4.2. External device 

setting 2 

5.4 Cable table 4 

RS–422 (4 wire) 

D4–440 

D4–DCM 

RS–232C 
3. TOP communication 

setting 

4.2. External device 

setting 2 

5.4 Cable table 4 

RS–422 (4 wire) 

communication 

port on CPU 

RS–232C 
3. TOP communication 

setting 

4.1. External device 

setting 1 

5.5 Cable table 5 

RS–422 (4 wire) 

D4–450 

D4–DCM 

RS–232C 
3. TOP communication 

setting 

4.2. External device 

setting 2 

5.4 Cable table 4 

RS–422 (4 wire) 

communication 

port on CPU 

RS–232C 
3. TOP communication 

setting 

4.1. External device 

setting 1 

5.6 Cable table 6 
RS–422 (4 wire) 

DL-305 D3-330 D3–DCM RS–422(4 wire) 

3. TOP communication 

setting 

4.2. External device 

setting 2 

5.7 Cable table 7 

 

■ Connection configuration 

 

ㆍ1:1 (one TOP and one external device) connection – configuration which is possible in RS232C/422 communication. 

 
 

ㆍ1:N (one TOP and multiple external devices) connection – configuration which is possible in RS422 communication. 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “KOYO Electronic Industries”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

DirectLogic Series Computer Link Computer Link 
 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 

Supported Protocol 

DirectNet 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project properties > TOP settings] → [Project option > Check “Use HMI settings” > Edit > Serial ] 

– Set the TOP communication interface in TOP Design Studio. 
 

 

 

 

 

Items TOP External device Remarks 

Signal Level (port) RS-232C 

RS-422 
 

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Project > Project properties > PLC settings > COM > “PLC1 : DirectLogic Series”] 

– Set the options of the communication driver of KOYO Electronic Industries – DirectLogic Series Computer Link in TOP 

Design Studio. 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “Computer Link”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Station Num Enter the prefix of an external device.  

Series selection Select the series of the external device.  
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

  

Items TOP External device Remarks 

Signal Level (port) RS-232C 

RS-422 
 

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 

 (2) Communication option setting 
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■ [ Main screen > Control panel > PLC ] 
 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “Computer Link”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Station Num Enter the prefix of an external device.  

Series selection Select the series of the external device.  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 
 

4.1 External device setting 1 (Port on CPU Unit) 

Use “DirectLogic Series” Ladder Software “DirectSOFT6 Programming” to set as follows. For more detailed setting method than that 

described in this example, refer to the PLC user manual. 
 

Step. 1 Create a new project. 

  
 

Step. 2 Execute [PLC > Connect] in the menu to set the communication method between PC and PLC and to connect to PLC. 

         
 

Step. 3 Execute [PLC > Setup > Setup Sec. Comm Port…] in the menu to set the serial communication parameters of the external device. 
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Items Settings Remarks 

Port Port 2  

Protocol DirectNET Required settings 

Station Number 1  

Baud rate 19200  

Stop bit 1  

Parity bit None  

Format Hex Required settings 

 

Step. 4 Send the settings to PLC. 
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4.2 External device setting 2 (D4-DCM) 

Use the Dip Switch of “D4-DCM” communication module to set the communication as follows. After completing the setting, reboot 

the power. 

For more detailed setting method than that described in this example, refer to the PLC user manual.   

 

1. Rotary Switch (Module front, Station No. Setting) 

Rotary Swtich Settings Settings Remarks 

Station No. x10 0 
Station No.  :  1  

Station No. x1 1 

 

2. DIP Switch SW4 setting (Back of the module , Serial Comm. Settings) 

DIP Switch Functions Settings Settings Remarks 

1 

Baud Rate *Note 1) 

On 

Baud rate transmission speed: 19,200bps  2 On 

3 On 

4 Parity Off None Parity  (On : Odd Parity)  

5 Self Test Off Self-diagnosis mode: OFF  

6 

Response delay time 

Off 

Response delay time: 0 ms  7 Off 

8 Off 

*Note 1) 

Baud SW 1 SW 2 SW 3 

4800 On Off On 

9600 Off On On 

19200 On On On 

38400 Off Off Off 

 

3. DIP Switch SW5 setting (Back of the module, Protocol Settings) 

DIP Switch Functions Settings Settings Remarks 

1 
Protocol selection *Note 1) 

Off 
DirectNet Slave Fixed 

2 Off 

3 
Communication Timeout Off 

Timeout enable/disable setting: Normal 

operation mode 
 

4 ASCII / HEX Mode Off Transmission mode: HEX mode Fixed 

*Note 1) 

Protocol SW 1 SW 2 

DirectNet Slave Off Off 

DirectNet Master Off On 

DirectNet Peer On Off 

Modbus RTU On On 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagrams described in this chapter may differ from the recommendations of “KOYO Electronic Industries Co., Ltd.”.) 
 

5.1 Cable table 1 (D2-240 – Port on CPU Unit) 
 

■ RS-232C (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 GND 

 

Based on 

communication 

cable connector 

front, 

6 pin male RJ12 

(male, convex) 

RD 2 2  

SD 3 3 RXD 

DTR 4 4 TXD 

SG 5 5  

DSR 6 6  

RTS 7  

CTS 8 

 
9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

5.2 Cable table 2 (D2-250-1 – Port on CPU Unit) 
 

■ RS-232C (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 5VDC 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin male 

(male, convex) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6  

RTS 7 7 SG 

CTS 8 8  

 

9 9 

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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5.3 Cable table 3 (D2-260 – Port on CPU Unit) 
 

■ RS-232C (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 5VDC 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin male 

(male, convex) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6  

RTS 7 7 SG 

CTS 8 8  

 

9 9 

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  6 RXD– 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin male 

(male, convex) 

 2 7 SG 

 3 9 TXD+ 

RDB 4 10 TXD– 

SG 5 11 RTS+ 

SDA 6 12 RTS– 

 7 13 RXD+ 

 8 14 CTS+ 

SDB 

9 15 

CTS– 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 1 : N connection - Refer to 1:1 connection to connect in the following method. 

TOP Cable connection and signal 

direction 

PLC Cable connection and signal 

direction 

PLC 

Signal name Signal name Signal name 

RDA 

 

SDA 

 

SDA 

RDB SDB SDB 

SDA RDA RDA 

SDB RDB RDB 

SG SG SG 
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5.4 Cable table 4 (D4-DCM) 
 

■ RS-232C (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1  

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin 

female (male, 

convex) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6  

RTS 7 7 SG 

CTS 8   

 
9 25 

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  14 OUT+ 

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin 

female (male, 

convex) 

 2 15 OUT– 

 3 17 IN+ 

RDB 4 16 IN– 

SG 5 7 0V 

SDA 6 10 RTS+ 

 7 12 CTS+ 

 8 11 RTS– 

SDB 
9 13 

CTS– 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 1 : N connection - Refer to 1:1 connection to connect in the following method. 

TOP Cable connection and signal 

direction 

PLC Cable connection and signal 

direction 

Terminating PLC 

Signal name Signal name Signal name 

RDA  14 OUT+  22 OUT+ 

RDB 15 OUT– 23 OUT– 

SDA 17 IN+ 24 IN+ 

SDB 16 IN– 25 IN– 

SG 7 0V 7 0V 

 

 10 RTS+  10 RTS+ 

 12 CTS+  11 CTS+ 

 11 RTS–  12 RTS– 

 13 CTS–  13 CTS– 

 22 OUT+  14 OUT+ 

 23 OUT–  15 OUT– 

 24 IN+  17 IN+ 

 25 IN–  16 IN– 
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5.5 Cable table 5 (D4-440 – Port on CPU Unit) 
 

■ RS-232C (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1  

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin 

female (male, 

convex) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6  

RTS 7 7 SG 

CTS 8   

 
9 25 

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  14 TXD+ 

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin 

female (male, 

convex) 

 2 16 TXD– 

 3 9 RXD+ 

RDB 4 10 RXD– 

 5 7 0V 

SDA 6 19 RTS+ 

 7 11 CTS+ 

 8 18 RTS– 

SDB 
9 23 

CTS– 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 1 : N connection - Refer to 1:1 connection to connect in the following method. 

TOP Cable connection and signal 

direction 

PLC Cable connection and signal 

direction 

Terminating PLC 

Signal name Signal name Signal name 

RDA  14 TXD+  14 TXD+ 

RDB 16 TXD– 16 TXD– 

SDA 9 RXD+ 9 RXD+ 

SDB 10 RXD– 10 RXD– 

SG 7 0V 7 0V 

 

 19 RTS+  19 RTS+ 

 11 CTS+  11 CTS+ 

 18 RTS–  18 RTS– 

 23 CTS–  23 CTS– 
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5.6 Cable table 6 (D4-450 – Port on CPU Unit) 
 

■ RS-232C (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1  

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin 

female (male, 

convex) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6  

RTS 7 7 SG 

CTS 8   

 
9 25 

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  14 TXD+ 

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin 

female (male, 

convex) 

 2 16 TXD– 

 3 9 RXD+ 

RDB 4 10 RXD– 

 5 7 0V 

SDA 6 19 RTS+ 

 7 11 CTS+ 

 8 18 RTS– 

SDB 
9 23 

CTS– 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 1 : N connection - Refer to 1:1 connection to connect in the following method. 

TOP Cable connection and signal 

direction 

PLC Cable connection and signal 

direction 

Terminating PLC 

Signal name Signal name Signal name 

RDA  14 TXD+  14 TXD+ 

RDB 16 TXD– 16 TXD– 

SDA 9 RXD+ 9 RXD+ 

SDB 10 RXD– 10 RXD– 

SG 7 0V 7 0V 

 

 19 RTS+  19 RTS+ 

 11 CTS+  11 CTS+ 

 18 RTS–  18 RTS– 

 23 CTS–  23 CTS– 
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5.7 Cable table 7 (D3-330 – Port on CPU Unit) 

 

■ 1:1 connection 

■ RS-422 
 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  14 OUT+ 

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin male 

(male, convex) 

 2 15 OUT– 

 3 17 IN+ 

RDB 4 16 IN– 

 5 7 0V 

SDA 6 10 RTS+ 

 7 12 CTS+ 

 8 11 RTS– 

SDB 9 13 CTS– 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 1 : N connection - Refer to 1:1 connection to connect in the following method. 

 

TOP Cable connection and signal 

direction 

PLC Cable connection and signal 

direction 

Terminating PLC 

Signal name Signal name Signal name 

RDA  14 OUT+  22 OUT+ 

RDB 15 OUT– 23 OUT– 

SDA 17 IN+ 24 IN+ 

SDB 16 IN– 25 IN– 

SG 7 0V 7 0V 

 

 10 RTS+  10 RTS+ 

 12 CTS+  11 CTS+ 

 11 RTS–  12 RTS– 

 13 CTS–  13 CTS– 

 22 OUT+  14 OUT+ 

 23 OUT–  15 OUT– 

 24 IN+  17 IN+ 

 25 IN–  16 IN– 



 

 External device connection manual for TOP Design Studio 18 / 18 

6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use.  

(1) DL-205 

Device Bit Address Word Address Remarks 

Input Relay X0000 ~ X0477 V40400 ~ V40423  

Output Relay Y0000 ~ Y0477 V40500 ~ V40523  

Control Relay C0000 ~ C0377 V40600 ~ V40617  

Special Relay 
SP000 ~ SP137 V41200 ~ V41205  

SP320 ~ SP617 V41215 ~ V41230  

Timer (Contact) T000 ~ T177 V41100 ~ V41107  

Counter (Contact) CT000 ~ CT177 V41140 ~ V41147  

Stage S000 ~ S777 V41000 ~ V41037  

Timer (Elapsed Value) ––––– V0000 ~ V0177  

Counter (Elapsed Value) ––––– V1000 ~ V1177  

Data Register V2000.0 ~ V3777.15 V2000 ~ V3777  

Special Register V7746.0 ~ V7777.15 V7746 ~ V7777  

 

(2) DL-305 

Device Bit Address Word Address Remarks 

I/O Relay 000 - 157 

700 - 767 

V000 –V014 

V070 – V076(first half 1 byte) 

 

Control Relay 160 - 377 

770 - 777 

V016 – V036 

V076 (latter half 1 byte) 

 

Shift Register 400 - 577 V040 - V056  

Timer/Counter(contact) 600 - 677 V060 - V066  

Timer/Counter  

(elapsed time) 

––– V600 - V677  

Data Register ––– V400 - V576  

 

(3) DL-405 

Device Bit Address Word Address Remarks 

Input relay X0000 ~ X0477 V40400 ~ V40423  

Output relay Y0000 ~ Y0477 V40500 ~ V40523  

Link relay GX0000 ~ GX1777 V40000 ~ V40077  

Link output relay GY0000 ~ GY3777 V40200 ~ V40377  

Control relay C0000 ~ C0377 V40600 ~ V40617  

Special relay 
SP000 ~ SP137 V41200 ~ V41205  

SP320 – SP717 V41215 ~ V41234  

Timer(contact) T000 ~ T377 V41100 ~ V41107  

Counter(contact) CT000 ~ CT177 V41140 ~ V41147  

Stage S0000 ~ S1777 V41000 ~ V41077  

Timer(Elapsed value) ––––– V0000 ~ V0377  

Counter(Elapsed value) ––––– V1000 ~ V1177  

Data register 1 V400.0 ~ V777.15 V400 ~ V777  

Data register 2 V1400.0 ~ V7377.15 V1400 ~ V7377  

Special register V7400.0 ~ V7777.15 V7400 ~ V7777  

Data register 3 V10000.0 ~ V37777.15 V10000 ~ V37777  

 


